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New installs (Requirements, Directory and file layout) 

by Brent » Fri Apr 09, 2010 3:20 am 

System requirements: 
PHP Version 5.0 or greater is required. 
MySQL extension must be enabled in php.ini 
GD extension must be enabled in php.ini 
File_uploads must be enabled in php.ini 
zlib must be enabled in php.ini 
Session.auto_start must be 0 (disabled in php.ini 

In Apache httpd.conf DirectoryIndex index.php (index.php must be specified as a default start-up file name) 

Make sure the following folders and files are writable. For Linux/Unix use the following:
chmod a+w image/
chmod a+w image/cache/
chmod a+w image/flash/
chmod a+w cache/
chmod a+w download/
chmod a+w config.php

This is the basic directory and file layout you need to achieve when uploading your files and folders.
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Common Web Server Problems 

by Brent » Fri Dec 25, 2009 5:02 am 

Underscore - If you have a problem with PHP files not loading that have an underscore in the name such
as user_group, it is caused by a security setting on the server to disallow the underscore in file names. Get
them to reconfigure this to correct.

Session Data - You may find Report on Line does not return all the data you expect. This may be caused
by Suhosin security mod for PHP. You will have to get the host to disable this to correct or install a
standard PHPini file.

PHP5.3- In version 1.0, if you are running with PHP5.3, you will get this error:
Deprecated: Assigning the return value of new by reference is deprecated.
This has been corrected in version 1.1. The reference operator needs to be removed when creating a new
class.
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Zone Shipping Topics Taken from Forum as at 6 July 2010

by Brent » Sat Mar 20, 2010 11:11 pm 

Zone Shipping is simply shipping that is based on the different destinations, or geo zones, based on the 
weight of the total order. 

For example, If your shipping from California USA. You can set a rate to other customers in other states, 
or other countries by setting up a zone for each destination, and then setting the shipping price for each 
weight range from you to other places. 

Setup 
1. Set up a new zone in Admin->Configuration->Localisation->Geo Zones
2. Click on the "Insert" icon to add a new 'Geo Zone'
3. Call it "California Shipping Zone" and click Save. You should now have a California Shipping Zone in
the list.
4. Click on the yellow folder icon to the left of the title
5. Click on the "Insert" icon to add a new 'Zone to Geo Zone'
6. From the 'Country' dropdown, choose 'United States'
7. From the 'Region / State' dropdown, choose an individual state (California), or choose 'All Zones' for
the same rate to all 50 states & provinces
8. Click 'Save'.
9. Repeat this process for UK, Australia, China, Japan, etc. anywhere you want to exclusively allow this
type of shipping to.
10. Goto Extensions->Shipping, find 'Zone' and click the "wrench/spanner" icon to configure it
11. You should see textboxes for all your new zones. Enter the cost per weight range in each of the cost
fields, based on the rates you want to use. The format is:
Weight:Cost with multiple values separated by a comma:
5:2.00, 10:4.00

Using the above example (with lbs and $ for the example) would mean that 
- Orders from 0-5.0lbs, the shipping cost is: $2.00 
- Orders from 5.1-10.0lbs, the shipping cost is: $4.00 
- Orders from 10.1lbs+ would not be eligible for zone shipping 

Set the rates based on your shipping couriers price table for the different destinations. 
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Enable/Disable Countries and Zones 

by Brent » Sat Jan 09, 2010 1:51 am 

In admin, you have the ability to enable or disable countries and zones. 

The cart download has only several countries enabled. All zones (states or provinces) for these countries
are available by default.
If you want to add a country, click the update in county and enable. All the zones for that country are now
available.
If there is a particular zone you don't want to allow customer access from, go to the Zones controller in
admin and update to disable that zone.
This gives the store owner complete control over customer account creation by country and zone.

A new feature that will be available in the upcoming release of version 1.1 is the ability to enable all
countries or disable all countries.
It is a toggle process. If you have any countries enabled and click the Enable/Disable button, all countries
are disabled. You can then click
the button again to enable all countries.

This feature is on the Demo.
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Currency Settings Topics Taken from Forum as at 6 July 2010

by Brent » Wed Dec 30, 2009 9:34 am 

In admin/configuration/localisation/currency 
Create whatever currencies you require. 
* Currency Title:_________________________ This is required
* Code: ________________________________ Use the attached excel to ensure you have the proper
code.
Symbol Left:____________
Symbol Right:___________
Decimal Places:_________
Value: 1.0000______________________You can enter 1.0000 as default for all currencies. This will be
updated.

After entering your currencies, go to admin/settings and set your default currency.
You then come back to currency and Update Rates. This will update all currency exchanges based on
your default currency.

When customers are using the cart and change currency, the new currency is tested for date stamp which
is good for 24 hours.
If the chosen currency rate is older than 24 hours, it is updated at this time and assigned a new date stamp
with the current time.
This makes updating the rates on a daily basis not a requirement.

Future Development: All currencies will be included in the database with Status enable/disable.
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Tax Setup 

by Brent » Sat Mar 20, 2010 11:08 pm 

Taxes in AlegroCart use a 'pool' method where first the geo zones are created, then the tax classes are 
created, then they are linked together. Then the tax classes are referenced by products & other charges 
reference them. This allows one tax class to be used for multiple charges (products, shipping, etc). 

Creating the Geo Zone 'name' 
1. In the admin panel, Goto 'Admin->Configuration->Localisation->Geo Zone' 
2. If the zone 'name' you want isn't already there, you can click "Insert" to create a new one. 
3. Enter the name & description. For example: 'California Zone' 
4. Click save. You should now see your new geo zone 'name' in the list. 

Creating the Geo Zone 'values' 
1. To the left of each geo zone name in the list is a 'yellow folder icon'. Click that to enter country & zone 
value for each geo zone name. 
2. On that page, Click "Insert". 
3. First select the Country value. For example: 'United States' 
4. Then the zone box should load all USA territories. Select the zone you want. For example: 'California' 
5. Click save. You should now see your new geo zone 'value' in the list. 
6. Repeat for additional country/zone combos that will fall under this zone 

Now the Geo Zone and its values exists in the 'pool'. The next step is to link the Tax Class to the Geo 
Zone 

Linking it to a Tax Class 
1. Goto 'Admin->Configuration->Localisation->Tax Class'
2. If the zone 'name' you want isn't already there, you can click "Insert" to create a new one.
3. After creating one, click the yellow folder icon to the left of the name.
4. On this page, click the "INSERT" button.
5. You should have some details to fill out:
Geo Zone: Choose from the drop down for the Geo Zone we created (e.g. California Zone)
Description: A brief description (e.g. "California Tax Zone")
Tax Rate: The tax percentage (e.g. 7.6)
Tax Priority: The priority this tax has on the total price. (e.g. 1)
6. Click Save.

Now the Tax class exists but we need to know which products or services will use this tax. 

Linking it to Products 
1. Goto 'Catalog->Product' 
2. Find the product you want to add tax to and edit it 
3. Under the Data tab, choose the tax class from the drop down. 
4. Click save. Now the tax will apply to this product at checkout 

Linking it to Shipping 
1. Goto 'Extensions->Shipping' 
2. Choose the shipping method you want to add tax to and click the "wrench" icon 
3. Choose the tax class from the drop down. 
4. Click save. Now the tax will apply to this shipping method at checkout 

Multiple Taxes. 
In Geo zones 
Set up a Geo Zone for a country. EG: Canada 
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Click the yellow folder and select Country: Canada, Zones: all zones Topics Taken from Forum as at 6 July 2010

Set up a GEO Zone for a province. EG: British Columbia 
Click the yellow folder and select Country: Canada, Zones: British Columbia 

Now go to Tax Class and click folder on your tax class.
Insert a new Geo zone, select Canada and enter rate. EG: 5%
Insert a new Geo zone, select British Columbia and enter rate. EH: 7%

Now, whenever the billing address is British Columbia, the tax will be 12%
All other provinces in Canada will be accessed a tax of 5%.
At this time, the tax display is the total tax accessed, not separate entries.
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URL Alias, Search Engine Optimization (SEO) 

by Brent » Sat Jan 02, 2010 8:40 am 

You must first enable URL Alias in admin settings to enable SEO URL's.
Select URL Alias in admin and click the Generate SEO button.

Your URL's will now be displayed as:
controller=product&path=1_11&product_id=14 is now all-and-products/related-products/related-1.html
controller=product&manufacturer_id=1&product_id=1 is now the-bike-builder-guys/product-1.html

The SEO is generated when a new product is added, product is updated, or deleted.

SEO is generated for all products, categories, manufacturers, information, all controller pages, and
pagination.

This process also occurs in manufacturer and category, but only for the manufacturer or category.
It does not regenerate SEO for child categories or products. If you are changing the name of a category or
manufacturer, you should regenerate the complete SEO. It requires less processing to do this than search,
delete and
regenerate for children of the item you changed.

NOTE: When you regenerate SEO, any custom changes you may have made are gone!
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Descriptions & Text Editor Tips Topics Taken from Forum as at 6 July 2010

by Brent » Sun Jan 17, 2010 4:10 am 

There are different text editor functions available to handle product descriptions, 
short description, and technical information. 

The formatted function is used on single or 3 column display in Manufacturer, Category, and
Search Pages, or modules the use 3 column display. It is also used on the Product detail
page for main product description and technical information.
It returns the number of lines specified with each line ending with <br> tag.
It allows using special formatting such as bold or color without the possibility of chopping a
line between an opening and closing tag.

The plain string function is used on the four column display and chops the text by number of
characters. For this reason, I would suggest always including an alternate short description with
no special formatting.

There is also a stripped string function that returns the number of words specified. I do not suggest
using this with any formatting. The plain string offers more control over your output. (a legacy item)

3 and 4 column displays will use the alternate display if available. Because the three column
display can display a specified number of lines, the best results are if each line length is limited
to 30 characters, end with a <br>(shift enter) tag.

When entering the main product description, you have the option to add a hidden description that will
not be displayed, but is available to your product search.
Some advantages are including slang terms or synonyms to aid in locating the product that you
would not want displayed in your product description. This feature as makes possible including detail
that you may not have room to include in the description.
EG: You want to list a part for a vehicle that covers a year range like 1992-1999 chev. If you customer
happens to type in 1994 chev, you would have no results returned.
With the hidden description, you would have:
1992-1999 chev
<hidden description>1992 1993 1994 1995 1996 1997 1999 1999 chevrolet Chevrolet chevy
The search will pick out the proper year plus any portion the the word text as high lited.

The hidden description insertion button is located on the lower right side of the FCK Editor
tool bar on the product page in admin. This inserts a tag in your description and everything after this
tag will not be displayed.

Brent 
Site Admin 

Posts: 103
Joined: Sun Dec 13, 2009 9:35 am

Private message 
E-mail Brent 

Top 
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Home Page Module 

by Brent » Fri Dec 25, 2009 12:06 pm 

The home page module will only appear on the home page the first time a visitor comes to your site.
You access the module in extensions/module/Home Page and click the wrench(configure).
Select the Homepage Data tab and click HomePage Entry
You will have a setting for how many times the home page module runs for each session.

You either create or edit an existing page here. 

Name & Status Tab: 
You give the page a name that is for your reference only. It is not used in the display. (REQUIRED) 
Set status to enabled if you are going to use this page. It will automatically disable all other pages. 
Only one page can be enabled at a time. 

Description Tab: (Language dependent)
Title: Title will be displayed on Homepage (REQUIRED)
Flash: Option flash file can be included here.
Default size for the flash is 550px x 250px, which can be set in admin if required.
Flash files must be uploaded to image/flash folder
Now includes upload button in admin to upload flash folder as of Version 1.1
Welcome: This is an option short text message (255 chars) that can be included.
Description: This is optional unlimited text that can also be included.
Image: Optional image file of type .jpg, .png, or .gif can be included here.
These images are located in the main image folder.

Meta Info: There is a tab for Default Meta Title, Meta Description and Meta Keywords.
These are available even if home page module is not enabled and are used as default if no other meta
information
is generated by a particular page.

Brent 
Site Admin 

Posts: 103
Joined: Sun Dec 13, 2009 9:35 am

Private message 
E-mail Brent 

Top 
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Template / Styles Version 1.2.3 + 

by Brent » Tue Jul 13, 2010 3:48 am 

The catalog Templates, Styles(css), and Color layout have changed for Version 1.2.3 as per the layout
diagram below.
In admin, you will have settings for selecting a default template, style, and color scheme.
There is also a setting for default page layout, 2 or 3 columns.
The template layout has 2 additional locations, extra which is located between the header and content area,
and page bottom located below the footer.

New in admin is the Template Manager.
You now have the ability to set page column layout and color scheme for each page.
You can also set the order and location for each module for an individual page.

With the addition of the template manager, module loading has changed from auto loading all modules to
only loading modules required for each particular web page. This will reduce redundant overhead by loading
and running modules that will not be used.

System Default Modules loaded.
HEADER: currency, language, navigation, search, and header.
COLUMN: cart, category, information
FOOTER: footer

In the template manager, you can over ride the default settings by selecting the default controller.
This will allow you to customize your default modules to be loaded and the locations for each.
The page column layout and color have NO effect in this default setting.
If you set a new default layout, be sure to include CONTENT in the content area.

The system defaults and template defaults are all over ridden by individual controller selections.
Example: Our basic layout is 3 column with neutral as the color.
Current Homepage defaults.
HEADER: currency, language, navigation, search, and header.
COLUMN: cart, category, and information (from default)
manufacturer, popular, and review (loaded from home controller extra modules)
CONTENT: content (this is sent by current controller, in the case empty)
homepage, featured and latest ( also loaded from home controller extra modules)
COLUMNRIGHT: specials (also loaded from home controller extra modules)
FOOTER: footer

In the template manager, we will select home as the controller and set status as enabled.
HEADER TAB: we will add currency, navigation, search, and header. The language has been left out
because we only have one language file and don't wish to load the language selector.
SUBHEADER TAB (extra): we will add homepage module to include a large flash banner here.
COLUMN TAB: we will add category, manufacturer, popular, and review.
CONTENT TAB: we will add content, featured, and specials here.
COLUMNRIGHT TAB: we will add cart and latest here.
FOOTER TAB: we do not need to change any thing here, so we leave it blank and it will load default footer
module.
PAGEBOTTOM TAB: we will add information to this location.

NOTE: any tab that you have content in will over ride the defaults, so you need to add all the entries you
require in that location tab. None of the defaults for that location will be loaded. Also, you need to be aware
of duplicate module entries in different locations resulting from adding a module to one location that already
exist as a default in another location.
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You can have different page columns. For example, you might set system page columns to 2 and set all the
catalog display controllers (home, manufacturer, category, search, and product) to 3 column layout in the
template manager.
This would result in all the account pages and checkout pages being 2 columns.

Creating new Color schemes:
You can create your own color scheme by copying an existing color css file and renaming to your new color.
Then create a color image folder to load any color specific images.
You then can make all the changes in one css file to reflect your new color and color images paths.

2 of 2 14-July-2010 09:37 



 AlegroCart • View topic - Template Layout - For updated information go to: http://forum.alegrocart.com/viewtopic.php?f=22&t=5 

Template Layout Topics Taken from Forum as at 6 July 2010

by Brent » Thu Dec 24, 2009 7:55 am 

NEW: Version 1.2.1 
The template and Styles are now separate folders.
The template folder includes content, module, and shared folders for .tpl files
The styles folder includes css and related image folders.
NEW 1.2.1 Selectable style colors. Style now includes a color folder with selectable color.css files.
These color.css files select color images located in the style/image/Yourcolor folder.
These are each set from settings in admin.

System is set to use default template and style folders. These should not be modified. They are your
backup.
If you will make changes, create your own folder under catalog/template/yourfolder
Do the same with the default style folder. Create your own to make modifications.
Copy all the files from default to this new directory and change the setting in admin settings to reflect the
change.
You now have settings in admin for template, style, and color.

The main controller .tpl files are in content
CSS and image files are self explanetory.

New items in the Module folder:
display_options.tpl - used by all modules for right column display options.
module_column.tpl - used by all display modules located in right or left column.
module_content.tpl - used by all display modules located in the center content area.
homepage.tpl
navigation.tpl

New Shared folder: these included tpl files are all shared files used by multiple controllers
add_to_cart.tpl - included in any tpl file that requires the add to cart button
pagination.tpl - the pagination display for manufacturer, category, and search
product_image.tpl - to display output of image on all display files
product_image_link.tpl - to display output of image on all display files with enlarge button
product_options.tpl - display product options with real time price updating (Select box)
b]product_options_radio.tpl[/b] - display product options with real time price updating (Radio Buttons)
product_price.tpl - displays price and or special pricing
single_column.tpl - main file for all single column displays.
multiple_columns.tpl - used to display 2 or more column displays

Header Logo is defined in color.css under (whichever color.css you chose)
#header .a {
background: url('../image/shoppingcart.png') no-repeat; You can also change this to define your own logo
name!
width: 460px;
height: 59px;

You can just create your own image, and if it is the same size (460x59px), just upload to the
styles/style/image/Yourcolor with the same name shoppingcart.png and you're set.

Due to the modular format, if you want to change something such as the image display, you just create a
new tpl
for the image output, name it whatever you like, and upload it to your shared folder.
You then just change the name in the main .tpl file, eg single_column.tpl where it calls the
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product_image.tpl: 

Code: Select all
 <?php include $shared_path . 'product_image.tpl';?> 

to 

Code: Select all 
<?php include $shared_path . 'YOUR_image.tpl';?> 

That's all there is to it. You still have the original .tpl but are now using your own. 
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Create a New Language Pack Topics Taken from Forum as at 6 July 2010

by Brent » Tue Apr 13, 2010 11:14 pm 

How to Create a language pack
Using "german" language as my example

STEP 1: Make copies of the original language file structure
ORIGINAL:
catalog/language/english
admin/language/english
COPY:
catalog/language/german
admin/language/german

Inside your new folder, eg: german, rename the file english.php to german.php

STEP 2: Change all the values within the new copy files to the translated language.
For example, english.php has:
Code:
.....
// Button
$_['button_list'] = 'List';
$_['button_insert'] = 'Insert';
$_['button_update'] = 'Update';
$_['button_delete'] = 'Delete';
$_['button_save'] = 'Save';
.....
In the german.php file it would be:
Code:
.....
// Buttons
$_['button_list'] = 'Liste';
$_['button_insert'] = 'Einfügen';
$_['button_update'] = 'Aktualisieren';
$_['button_delete'] = 'Löschen';
$_['button_save'] = 'Speichern';
.....

Do that for all the language files.
Be aware when you see %s . This is a place holder for test to be inserted.
$_['text_results'] = 'Results %s - %s of %s';
This would be:
$_['text_results'] = 'Ergebnisse %s - %s von %s';

STEP 3: include a famfamfam icon flag for the matching country. Name it xx.png (match the language
code) into the catalog/styles/image folder
Example for german language: de.png in the catalog\styles\image folder
http://www.famfamfam.com/lab/icons/flags/ 

STEP 4: Insert the new language code in admin. 
Language Name: German 
Code: de 
Flag Image: de.png 
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Directory: german 
Main Filename: german.php 
Sort Order: 2 

Many codes are listed in library/language/language.php 
Also/ for more, see: http://msdn.microsoft.com/en-us/library ... 85%29.aspx 

But you should be sure that for each language you install, that you also update all the locations that will 
refer to that language when selected. 
- All categories need to be edited to get the name and description translations. 
- All products need to be edited to get the name and description translations. 

You will have to add the translations to the following sections: 
- Default Order Statuses 
- Default Payment Modules 
- Default Shipping Modules 
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Uploading Working Copy to Production Server (New Install) Topics Taken from Forum as at 6 July 2010

by Brent » Tue Feb 23, 2010 5:19 am 

If you are creating a website on a local server with something like WAMP Server or XAMPP Server for
windows,
these instructions will show how to get your local copy to a production server.

Step 1:
On your local server, go to admin backup/restore.
Click the download backup button and save a copy to your local website.
The file will be named backup.sql .

Step 2:
In the distribution zip file you downloaded, upload all the files located in the upload folder to production
server.
(don't upload the the upload folder itself, it is only a container to hold the files you are uploading)
Follow the new install instructions supplied with the distribution for new installs.
Create a copy on config.php and name it myconfig.php as a backup for this file.

Step 3:
Once you have created the new installation and deleted your install folder, you are ready to upload your
local copy.
upload your image folder and catalog folder to included any additional files or changes you have created
in your local working copy.

DO NOT upload the config.php file from your local server. This file is created in the new install and is
server specific.
It never needs to be uploaded again. You should make a copy of this file and keep in a safe place.

On you production server, go to admin backup/restore.
Click the browse button and select the backup.sql file on your local computer that you created in Step 1.
Save to your production server.
Or, you can run the local back-up.sql in phpMyAdmin on the production server.

Everything should now function as it did on your local server.
If for some reason your display is not correct, check the .htaccess file. If your site is not located in the
document root,
public.html/ or www/, but in a folder like www/store/, you need to reflect this in the .htaccess file as per
example.
EG: RewriteBase /store/ ( if store is directory cart is located in , eg: www/store/cart )

Also see File layout
Note: for Versions 1.2 and lower, if your using PHP 5.3, see viewtopic.php?f=15&t=61
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